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1    Notice

Pixel characteristics 
This LCD/LED product has a high number of 
color pixels. Although it has effective pixels of 
99.999% or more, black dots or bright points of 
light (red, green or blue) may appear constantly 
on the screen. This is a structural property of 
the display (within common industry standards) 
and is not a malfunction.

Any operation expressly prohibited in 
this manual, or any adjustments and 
assembly procedures not recommended 
or authorised in this manual shall void the 
warranty.

Warranty
No components are user serviceable. Do not
open or remove covers to the inside of the
product. Repairs may only be done by Philips
Service Centres and official repair shops. 
Failure to do shall void any warranty, stated
or implied.
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Risk of injury or damage to the TV!
• Two people are required to lift and carry 

a TV that weighs more than 25 kg or 55 
lbs.

• When stand mounting the TV, use only 
the supplied stand. Secure the stand to 
the TV tightly. Place the TV on a flat, level 
surface that can support the combined 
weight of the TV and the stand.

• When wall mounting the TV, use only a 
wall mount that can support the weight of 
the TV. Secure the wall mount to a wall 
that can support the combined weight of 
the TV and wall mount.PE Electronics 
Ltd.  bears no responsibility 
for improper wall mounting that result in 
accident, injury or damage.

Risk of injury to children!
Follow these precautions to prevent the 
TV from toppling over and causing injury to 
children:
• Never place the TV on a surface covered 

by a cloth or other material that can be 
pulled away.

• Ensure that no part of the TV hangs over 
the edge of the surface.

• Never place the TV on tall furniture (such 
as a bookcase) without anchoring both 
the furniture and TV to the wall or a 
suitable support.

• Educate children about the dangers of 
climbing on furniture to reach the TV.

Risk of swallowing batteries!
• The product/remote control may 

contain a coin-type battery, which can be 
swallowed. Keep the battery out of reach 
of children at all times!

Risk of overheating! 
• Never install the TV in a confined space. 

Always leave a space of at least 4 inches 
or 10 cm around the TV for ventilation. 
Ensure curtains or other objects never 
cover the ventilation slots on the TV.

2    Important

Read and understand all instructions before you 
use your TV. If damage is caused by failure to 
follow instructions, the warranty does not apply.

Safety

Risk of electric shock or fire!
• Never expose the TV to rain or water. 

Never place liquid containers, such as 
vases, near the TV. If liquids are spilt on 
or into the TV, disconnect the TV from 
the power outlet immediately. Contact 
Philips Consumer Care to have the TV 
checked before use.

• Never place the TV, remote control or 
batteries near naked flames or other 
heat sources, including direct sunlight. To 
prevent the spread of fire, keep candles 
or other flames away from the TV, remote 
control and batteries at all times.

• Never insert objects into the ventilation 
slots or other openings on the TV.

• When the TV is swivelled ensure that 
no strain is exerted on the power cord. 
Strain on the power cord can loosen 
connections and cause arcing.

Risk of short circuit or fire!
• Never expose the remote control or 

batteries to rain, water or excessive heat.
• Avoid force coming onto power plugs. 

Loose power plugs can cause arcing or 
fire.
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alcohol, chemicals or household cleaners 
on the TV.

• Risk of damage to the TV screen! Never 
touch, push, rub or strike the screen with 
any object.

• To avoid deformations and colour fading, 
wipe off water drops as soon as possible.

Risk of damage to the TV! 
• Before you connect the TV to the power 

outlet, ensure that the power voltage 
matches the value printed on the back 
of the TV. Never connect the TV to the 
power outlet if the voltage is different.

Risk of injury, fire or power cord damage! 
• Never place the TV or any objects on the 

power cord.
• To easily disconnect the TV power cord 

from the power outlet, ensure that you 
have full access to the power cord at all 
times.

• When you disconnect the power cord, 
always pull the plug, never the cable.

• Disconnect the TV from the power 
outlet and antenna before lightning 
storms. During lightning storms, never 
touch any part of the TV, power cord or 
antenna cable.

Risk of hearing damage! 
• Avoid using earphones or headphones at 

high volumes or for prolonged periods of 
time.

Low temperatures
• If the TV is transported in temperatures 

below 5°C or 41°F, unpack the TV and 
wait until the TV temperature matches 
room temperature before connecting the 
TV to the power outlet.

Screen care

• Avoid stationary images as much as 
possible. Stationary images are images 
that remain on-screen for extended 
periods of time. Examples include: 
on-screen menus, black bars and time 
displays. If you must use stationary 
images, reduce screen contrast and 
brightness to avoid screen damage.

• Unplug the TV before cleaning.
• Clean the TV and frame with a soft, 

damp cloth. Never use substances such as 

Product disposal Guidelines:

RoHS
COMPLIANT

Visit-http://www.philips.com
OR Toll 1860 200 0129

For the purpose of recycling to facilitate effective utilization of resources, please
return this product to a nearby authorized collection center, registered dismantler,
recycler, service center when disposing of this product.
In case of further assistance, you may contact nearest authorized service center.
Or Please see the Company website for further information on collection centers etc.
Visit-http://www.philips.com
OR Toll 1860 200 0129

(              )



different as per model selection.

Note :

1) Above sketch and connectivity are just for representation actual product may look

Congratulations on your purchase, and welcome to Philips. To fully benefit from the 

support that Philips offers, register your TV at www.philips.com/welcome.

3.1  Name and Function of Control on Set

EN  5

3 Use your TV
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1)  IR SENSOR

3)    KEY BOARD

1
2

3

SOURCE MENU VOL-/+ CH-/+ STANDBY
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3.2  Name and Function of Control on Set
 (40PFL5059/V7 & 50PFL5059/V7 & )55PFL5059/V7

A) TV controls and Indicators
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3)    KEY BOARD
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different as per model selection.

Note :

1) Above sketch and connectivity are just for representation actual product may look

1)  AC POWER IN

5)    USB
4)  HDMI 

6)  AV OUT

B) Connectivity
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3.3  Name and Function of Control on Remote

 EN  7 

10

1

2

3

4

5

6

7

8

9

11

12

13

14 15

16

17

18

19

20



3.4 Remote control usage

2 Multimedia Control buttons
• Control video or music.

 

3  SOURCE
 

• Selects connected devices.

When you use the remote control, hold it close 
to the TV and point it at the remote control 
sensor. Make sure that the line-of-sight between
the remote control and TV is not blocked by 
furniture, walls or other objects.

(  Navigation buttons)
• Navigate through menus and select 

items. (Also in USB mode).   

 
6

• Return to the previous menu or exit 
a function.

  
9 

OK
 
7

• Confirm an entry or selection.    

1 (Standby-On)
• Switches the TV ON or OFF. 

The TV is not powered off completely
unless it is physically unplugged

~5m

~30º

4

• Access the TV mode.
TV 

5
• Access the Channel List.

LIST

8

11 +/-
• Adjust volume.

10 

• Switch channels or navigate through 
menu pages, tracks, albums or 
folders.

   CH - / CH +   Previous/Next ) )

12
 
Color buttons
• Select tasks or options.

0-9  Numeric buttons 

• Select channels.

13 

14 SUBTITLE
• Depending on model.

TEXT
• Depending on model.

15 

Mute or restore audio.• 

16 

OPTIONS
• Access the menu to adjust settings. 

17 

INFO

• Displays the status information. 

18 

19  ( Home ) 
• Access the home menu.

20

  8  EN 

• Adjust picture format.    
FORMAT

ADJUST
• Access the menu to adjust settings.



3.5 Battery Installation

 3. Refix the battery compartment  door.

1. Remove the battery compartment door.
2. Install 2 “AAA” or UM-4 (1.5V) batteries or equivalent with the correct polarity
    as indicated.

EN  9



[Setup] : Access menus to change 

picture, sound and other settings.

1  

2  

3  

• [Smart picture] : Access predefined smart 
picture settings.

• [Contrast] : Adjust the intensity of 
backlight areas, while the video contents 
are kept unchanged.

• [Brightness] : Adjust the intensity and 
details of dark areas.

• [Color] : Adjust color saturation.

• 

[Hue]: Compensate for color variations.
(Available only for NTSC channels).

• 

[Sharpness] : Adjust sharpness in the 

image.

4 Use more of 
your TV

4.1 Main Menu

Menus help you to install channels, change 
picture and sound settings and access other 
TV features.

1 Press  

2 Select one of the following, then press 
OK

• [Watch TV] : If a source other than 

antenna is selected, switch back to 
the antenna source

• 

• [Device List]         : Access menus to 

change other source by pressing key.

• 

[Browse USB]:  View photos and 
play music and movies contained in 
USB storage devices.

Press       to move, and press        to adjust.

Press .

Select [Setup] then press OK 

Select one of the following settings, then 
» The menu screen appears.

Watch TV Device List

Browse USB Setup

: Select picture format.• [ ]Format

• [Noise Reduction]: Filter and reduce noise
in an Image, you can switch this feature

• [Dynamic contrast] : Enhance 
contrast, you can switch this feature 

• [Flesh Tone]: Make colors more vivid and 

improve the details in bright colors. You can 

switch this feature ON or OFF.

[Pixel Precise HD] :

To enhance the picture quality 

• 

Low,Middle and High. 

Low,Middle and High. 

> Select [Picture].

4.2 Manually adjust picture setting

Picture

Sound

Features

Installation

Smart Picture

Contrast

Brightness

Color

Hue

Sharpness

Pixel Precise HD

Format

Picture

Sound

Features

Installation

Dynamic Contrast    

Noise Reduction   

Off

Middle

Flesh Tone Off

OffDynamic Backlight

• [Dynamic Backlight]:   Enhance brightness
you can switch this feature low, middle,
High, Off.

 10  EN 



2
 

Select one of the following settings, by 

• 

[Personal]: Apply your customised 

• [Vivid] : Rich and dynamic settings, 

ideal for daytime.
[Cinema] : Ideal settings for movies.• 

[Bright]: Ideal settings for night time.

• 

4.3 Use Smart Picture
Use smart picture to apply pre-defined 
picture settings.

picture settings.

1 Press     ADJUST. 

  

Smart Picture Vivid

[Color Temp.] : Adjust the color balance 

 in an image.

 [Freeze]

 

: Select option as ON to freeze the 
picture.

Note

 
• Depending on the format of the picture 

source, some picture settings may not be available.

• 

• 

Picture

Sound

Features

Installation

Color Temp.

Freeze

 

4.4 Manually adjust sound setting

1 Press .

2

• 

[Equalizer] : Adjust the equalizer ON
various frequencies.

Press       to move, and press        to adjust.

3

 

Select one of the following settings, then 

• [Smart Sound]  : Access predefined smart 

sound settings.

• 

• 

• 

Auto volume leveler• [AVL] :

automatically reduces sudden 
 volume changes, for  example when 
switching channels. 

[Bass] :

[Treble] :

[Balance] : Adjust the balance of the right 
and left speakers.

 Adjust the bass level.

Adjust the treble level.

Picture

Sound

Features

Installation

Smart Sound

Balance

Treble

Bass

AVL

Equalizer

Incredible Surround

Select [Setup] then press OK 

> Select [Sound].

[Incredible  Surround ] :
Enable Incredible Surround for stereo
Sources

• 

4.5 Use Smart Sound
Use smart sound  to apply pre-defined 
Sound settings.

2
 

Select one of the following settings, by 

1 Press     ADJUST. 

  

Smart Sound Standard

 • [Standard] : Settings that suit most 
environments and types of audio.

• [Movie] : Ideal settings for spoken audio, 

such as news.

• [Music] : Ideal settings for listening to music.

• [Personal]: Apply the settings that were 
customised in the sound menu.

 EN  11



4.6 Features Menu
1 Press 

2 Select [Setup]
 > Select [Features]

then press    OK

3 Select one of the following settings then

Press      to move, and press       to adjust.

• [OSD Duration] :This function is used to OSD

timeout in step of  5,15,30,45,60 secs.

• [Factory Settings] :This function is used for 

• [Blueback] :This function is used to ON/OFF

the blue  screen at no signal condition.

• [Sleep Time] :This function is used to ON/OFF

step of 10,20,30,60,90,120,180,240 mins.

Reset to factory default settings.

• [Back Light] :Adjust the back light brightness.

• [ ]Easy Link :HDMI CEC  switch.ON/OFF

[Features in VGA Mode] :

• [Auto Adjust]: This automatically adjust

H & V-position, Phase and Clock for VGA 
mode.

• [V-Position]: Adjust the vertical 

position of image [Only in VGA].

•    [H-Position]: Adjust the horizontal 

position of image [Only in VGA].

• 

Back Light

[Clock]: Adjust the picture if not in sync• 

with TV screen.

• 

[Phase]: Adjust the picture if there is any• 

blurring or shimmer in text.

[Only in VGA].

• 

Picture

Sound

Features

Installation

OSD Duration

Blueback

Back Light

Factory Settings

Sleep Time

Easy Link
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4.7 Installation Menu

 is not reproduced properly.

Note: For India color system is Auto or

PAL.

•    [Sound System]: Change the sound 

• [Manual ]Search :Select this for manually

channels.

•    [Auto Search] :Select the function TV 
set will start auto tuning for all available

1 Press .

2 Select [Setup]
 > Select [Installation]

then press    OK

3 Select one of the following settings, then 

• [Color System] : Change the color system 

(AUTO/PAL/NTSC) setting if the picture

sound system (BG/M/DK/I) setting if sound 
is not reproduced properly.
Note: For India sound system is BG.

searching the channels,select the function
from which tuning will start.

 [Fine Tune]:  You can Fine tune the program,

In case poor reception.

• 

Press       to move, and press      to adjust.

 [Skip]:This function is used to Skip any • 
program.

 [Channel Edit]:  You can Delete, Rename,

Move or Skip any programmes.

• 

Sleep Time



Delete
Select Delete option by Pressing Red color 
button,the program will be deleted.

2                 62.25MHz               -----              Off

3                 69.25MHz               -----              Off

4                 76.25MHz               -----              Off

5                 97.25MHz               -----              Off

6               112.25MHz               -----              Off

7               119.25MHz               -----              Off

8               126.25MHz               -----              Off

9               147.25MHz               -----              Off

10             161.25MHz               -----              Off

1                 55.25MHz               -----              On

Rename

Rename
Move the cursor to the program, Select
Rename option by pressing Green color button 
to rename the program. Press        to choose 

 Press        to move the cursor.the character. 

Press OK button to Enter , 
Press Menu button to Return the Edit Menu.

1
 

While you watch ATV, press 
 

 

The ATV channel list menu appears.

2 Access or select the channels by     .

4.10 Use the List menu
LIST

Program Edit

48.25MHZ

83.25MHZ

105.25MHZ

1

2

3

5 Play photos, music and videos 
on USB storage devices

175.25MHZ

203.25MHZ

224.25MHZ

463.25MHZ

545.75MHZ

4

5

6

7

8

9

1
 

While you watch TV, press 
 

FORMAT

 

The TV format menu appears to adjust.

2 Select or switch the option by       .

4.9 Use the Format menu

picture format.

 EN  13 

 and press      to move the program.

Move
Move the cursor to the program, Select 
Move option by pressing Yellow color button 

Skip
Select Skip option by pressing Blue color  
button to skip this program.

Select program no on which you want move  
the current program, then press ok key.  

1
 

While you watch TV, press 

 
OPTIONS.

 

The TV options menu appears for

2 Select one of the following options,switch to 
ON/OFF by       .
• [Freeze ]:   Freeze the moving picture 

[ ]:Incredible  Surround

4.8 Use the Options menu  

Freeze Off

  

Incredible Surround Off

Freeze and Incredible Surround by pressing 
options key cyclic. 

Enable Incredible Surround for stereo
Sources

5.1 Connect a USB storage device to play 
photos, music or videos stored on it.

1 Switch on the TV.

2 Connect the USB device to the USB port 
on the side of your TV.

3 Press 

4 Select [Browse USB], then press OK
The USB browser appears.

5.2 View photos
1 In the USB browser, select [Photo], then

press OK.

2 Select a photo or a photo album by pressing 

5.3 View a slide show of your photos

 

Press the following buttons to control 
play of selected photos.:

•  to play.

•  to pause.
•  or  to play the previous or next 

photo.

Select photos by pressing OK key :

OK key,then press    to view the photo. 



5.4 Listen to music

1 In the USB browser, select [Music], then 
press OK.

2 Select a music track or album by pressing 

 
•  to play.

•  to pause.
•  or  to play the previous or next 

OK key.

5.5 Watch video

1
 
In the USB browser, select [Movie],then 
press OK.

2

 3 To control play, press the play buttons:
•  to play/pause.

•  or  to play the previous or next 
video.

5.6 Text

1 In the USB browser, select [Text], then 
press OK.

2 Select a Text File, then Press      to play.

Select video files by pressing OK key.

5.7 Music, Photo, Movie, Text
mode control menu bars 

You can select the multimedia functions

like play, Pause, FF, FB, Next, Previous.

Stop etc.

To use above functions press OK key
while playing files on TV screen.

Picture mode menu bar:

Press       to select the function icon, press  
OK button to confirm the function. 

Music mode menu bar:

Movie mode menu bar:

Press       to select the function icon, press  
OK button to confirm the function. 

Press       to select the function icon, press  
OK button to confirm the function. 

Step Forward

Press       to select the function icon, press  
OK button to confirm the function. 

Text mode menu bar:

5.8 Disconnect a USB storage device

Caution

• Follow this procedure to avoid damage to your 
USB storage device.

1 Press      to exit the USB browser.

2 Wait for five seconds, then disconnect 
the USB storage device.
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6.2 TV channel issues
Previously installed channels do not appear in 
the channel list:

 

Check that the correct channel list is 
selected.

6.3 Picture issues
The TV is on, but there is no picture:
 

Check that the antenna is properly 
connected to the TV.
Check that the correct device is selected 
as the TV source.

There is sound but no picture: 
Check that the picture settings are 
correctly set.

There is poor TV reception from an antenna 
connection:

Check that the antenna is properly 
connected to the TV.
Loudspeakers, unearthed audio devices, 
neon lights, high buildings and other large 
objects can influence reception quality. 
If possible, try to improve the reception 
quality by changing the antenna direction 
or moving devices away from the TV.
If reception on only one channel is poor, 
fine tune this channel.

There is poor picture quality from connected 
devices:

Check that the devices are connected 
properly.
Check that the picture settings are 
correctly set. 

The TV did not save your picture settings:
Check that the TV location is set to the 
home setting. This mode offers you the 
flexibility to change and save settings.

The picture does not fit the screen; it is too 
big or too small:

Try using a different picture format.
The picture position is incorrect:

 

Picture signals from some devices may 
not fit the screen correctly. Check the 
signal output of the device.

6   Troubleshooting

This section describes commonly encountered
issues and accompanying solutions.

6.1 General TV issues
The TV does not switch on:

Disconnect the power cable from the power 
outlet. Wait for one minute then reconnect it.
Check that the power cable is securely 
connected.

The remote control is not working properly:
Check that the remote control batteries 
are correctly inserted according to the +/- 
orientation.
Replace the remote control batteries if they are 
flat or weak.
Clean the remote control and TV sensor lens.

The standby light on the TV blinks red:
Disconnect the power cable from the power 
outlet. Wait until the TV cools down before 
reconnecting the power cable. If the blinking 
reoccurs, contact Philips Consumer Care.

When turning the TV on/off/to standby, you hear a 
creaking sound from the TV chassis:

No action is required. The creaking sound is 
normal expansion and contraction of the TV as it 
cools down and warms up. This does not impact 
performance.

EN  15



1. Press 
2. Select [Setup] >[Features] >

[Auto Adjust].

6.4 Sound issues
There is a picture but sound quality is poor:

Note

If no audio signal is detected, the TV 
automatically switches the audio output off
this does not indicate malfunction.

Check that all cables are properly connected.
Check that the volume is not set to 0.
Check that the sound is not muted.

There is a picture but the sound quality is poor:
Check that the sound settings are correctly 
set.

There is a picture but sound comes from one 
speaker only:

Verify that sound balance is set to the centre.

6.5 HDMI connection issues
There are problems with HDMI devices:

If the TV does not recognise the HDMI 
device and no picture is displayed, try 
switching the source from one device to 
another and back again.
If there are intermittent sound disruptions, 
check that output settings from the HDMI 
device are correct.
If you use an HDMI-to-DVI adapter or 
HDMI-to-DVI cable, check that an additional 
audio cable is connected to AV IN.

6.6 Computer connection issues
The computer display on the TV is not stable:

Check that your PC uses the supported 
resolution and refresh rate.
Select the  “Auto Adjust” function.

6.7 Contact us
If you cannot resolve your problem, refer to the 

FAQs for this product at www.philips.com/support.  

or Contact Customer Service Center. 

Warning
 

Do not attempt to repair the product yourself. 
This may cause severe injury, irreparable 
damage to your product or void your 
warranty.

Note 
Make a note of your TV model and serial 
number before you contact Philips. These 
numbers are printed on the back of the TV 
and on the packaging.

16  EN 



7.2 Tuner/Reception/
Transmission

Antenna input: 75ohm coaxial (IEC75)
TV system:  PAL, B/G
Video playback: NTSC,PAL
Tuner Bands: UHF, VHF

7.3 Remote control

Type: XY-8091
Batteries: 2 x AAA (LR03 type)

7.5 Power
Mains power: AC 110-240V~, 50/60Hz

Ambient temperature: 5 to 40 degrees 
Celsius
Power consumption

7 Product 
information

Product information is subject to change 
without notice. For detailed product 

information, go to www.philips.com/support.

7.1 Supported display resolutions

Resolution - refresh rate:
640 x 480 - 60Hz,72Hz,75Hz

800 x 600 - 56Hz,60Hz,72Hz,75Hz

1280 x 1024 - 60Hz

Resolution - refresh rate:
720 x 480i - 60Hz
720 x 480p - 60Hz
720 x 576i - 50Hz
720 x 576p - 50Hz
1280 x 720p - 50Hz, 60Hz
1920 x 1080i - 50Hz, 60Hz

Resolution - refresh rate:

Computer formats (HDMI)

Computer formats (VGA)

1024 x768 - 60Hz,70Hz,75Hz

Video Formats

720 x 480p - 60Hz

720 x 576p - 50Hz
1280 x 720p - 50Hz,60Hz
1920 x 1080p -50Hz,60Hz 

7.4  Multimedia

Supported USB storage device: 
(Only FAT 16 or FAT 32 USB storage 
devices are supported) 

Supported storage file formats:
Images : JPEG, BMP, PNG

Audio :  MP3,WMA.

Note

USB   names must not exceed 128 
characters. 

file1)

2) The USB features/functions may vary 
from file to file depending on relative  
information present in the file

Video :

Text : TEXT

Note

1080p support only for FHD model1)

Note :- HD Natural Motion are inbuilt feature in chipset solution.
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    55PFL5059/V7: 120W

   50PFL5059/V7: 100W

   40PFL5059/V7: 70W

   32PFL5039/V7: 60W

   29PFL5039/V7: 55W

   



7.6 Supported TV mounts

Warning

Follow all instructions provided with the TV 
mount. PE Electronics Ltd. bears no 
responsibility for improper TV 
mounting that results in accident, injury or 
damage.

 TV screen
size (inches)

Required 
pitch (mm)

Required 
mounting bolts

7.7 Product specification
Design and specifications are subject to change 

without notice.

With TV stand

Dimension(WxDxH): 1241 x 263 x  780 (mm)

Weight: 14.3 kg

Without TV stand

Dimension(WxDxH): 1241 x 62 x 730  (mm)

Weight: 13.4 kg

55PFL5059/V7

With TV stand

Dimension(WxDxH): 1127 x 263 x  716 (mm)

Weight: 11.4 kg

Without TV stand

Dimension(WxDxH): 1127 x 62 x 666   (mm)

Weight: 10.5 kg

50PFL5059/V7

    
50PFL5059/V7   400x200         4 x M6

   40PFL5059/V7   200x100         4 x M6
   32PFL5039/V7   200x100         4 x M4
   

55PFL5059/V7   400x200         4 x M6
   

29PFL5039/V7   200x100         4 x M4

With TV stand

Dimension(WxDxH): 903 x 200 x 567   (mm)

Weight: 6.8 kg

Without TV stand

Dimension(WxDxH): 903 x 69 x 528   (mm)

Weight: 6.2 kg

40PFL5059/V7 

With TV stand

Dimension(WxDxH): 656 x 200 x 437   (mm)

Weight: 4.3 kg

Without TV stand

Dimension(WxDxH): 656 x 68 x 397   (mm)

Weight: 3.7 kg

   29PFL5039/V7 

To mount the TV, purchase a Philips TV mount 
or VESA - compatible TV mount. To Prevent  

damage to cables and connectors, be sure to 
leave a clearance of at least 2.2 inches or 5.5 cm 

from the back of the TV.
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With TV stand

Dimension(WxDxH): 731 x 200 x 481   (mm)

Weight: 4.9 kg

Without TV stand

Dimension(WxDxH): 731 x 68 x 440   (mm)

Weight: 4.3 kg

   32PFL5039/V7 



Table Stand Installation

1. Place the TV with the display side down on a flat surface, Use a cloth to protect the display.
2. Flat base, the base will be one of the pillars placed in the end seat, make sure the screw holes 
on the base and the base of the pillars aligned. Let screws into the base of the hole and tighten 
the screw.  In the same way to install another base pillars. 

Notes:      If the table stand has been assembled, just ignore the following instructions.
                 Follow the instructions accordingly based on the table stand supplied to you and 
                 graphics shown below are for illustrative purposes only.
                 The TV unit and screws is subject to material object.    

Notes:     Graphics contained within this publication are presentation only.
                 When the TV faced down, do not impact the screen with sharp edges to avoid 
                 scratching the screen.
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3. Install the screw holes on the back of the base and the base pillars aligned television reserved.

4. Let the four screws into the screw holes and tighten the back of the TV.



Consumer Guidelines

1.Kindly ensure that the dealer fills out warranty card correctly.
2.To avail the Warranty please register your product with the Philips-

• Log on to www.Philips.com
OR
• Contact Philips Consumer Care Centre

3.In the unlikely event of a defect developing in the TV set contact the Philips Customer
  Care Centre for obtaining warranty service and inform of the defect observed in the 
  set, the type no. and serial no. of the set.

4.On your lodging a complaint, a trained technician will call on you promptly. In the
   event of the technician deciding that set requires attention at the service station;the
    technician would arrange to get the set  picked up  to be delivered to service station 
   for further attention. “Homecalls” by the technician would however be restricted within
   municipal limits of the city/town in which the set has been registered.the 

Type no. Serial No.  Date of Purchase
Purchased By: Name
Address:

Tel.No.
Sold by: Name
Address:

                                                             
                                                             Sold by(User rubber stamp)

   

   Serial no.: 

Contact Customer Service Executive at:

Regd Office: PE Electronics Ltd,Auto Cars Compound,Adalat Road,Aurangabad,431005.

Tel.No.

Model no.:  

Toll :- 1860 200 0129
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   55PFL5059/V7

   50PFL5059/V7

   40PFL5059/V7

   32PFL5039/V7

   

   

29PFL5039/V7



of that town.

WARRANTY

This TV receiver is covered under                           from whom the set has been purchased or
warranty against any defect arising out                   through an Authorised Service Center for
of faulty or defective material or workman               warranty service. However, if the
ship for a period of 12 months from the                   Purchaser has to shift his residence to
date of purchase.                                                    another town on account of transfer or
                                                                                other reasons, the warranty benefit will be

  Should a defect develop in this set during               available at the Authorised Service Center
the period of warranty, PE Electronics
Limited undertakes to get the
set repaired free of charge either

The warranty is not valid in case of any of
the following events:

The TV set is not used according to instructions given in the ‘Direction for use’ 
/ ‘User Manual’

Defects are caused by improper or reckless use.
Any repair work carried out by persons other than a Philips dealer or Authorised
 Service Center.
Any modification or alteration of any nature made in the electrical circuitry of the set.
This Warranty Card is not completed and signed immediately on delivery of the set
by the Philips Dealer.
Fading effects and/or Ghosts (Multiple Image) in picture, if any,arising due to location
/ signal reception.
Defects due to causes beyond control like lightning, abnormal voltage, Acts of God or
while in transit to purchaser’s residence.

      (Refer Consumer Guidelines for further details)
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